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Proteins
• Proteins are large biomolecules that contain one or more long chains 

of amino acid residues.

• Proteins perform a vast array of functions within organisms.
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Membrane protein, opsin Protein-protein complex Protein-substrate complex



3-D structural information
Sources of structures:
1. X-ray Crystallography
2. Cryo-EM
3. NMR
4. Homology modeling

3Stick, tube and cartoon representation of protein
https://www.ks.uiuc.edu/Training/SumSchool/materials/sources/tutorials/01-vmd-tutorial/html/node2.html



Protein Data Bank
• PDB provides the information about the 3D shapes of proteins, nucleic 

acids, and complex assemblies
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Binding of biomolecules
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Ø Provides insight into mechanism of binding
Ø Possible pathways for entry and exit
Ø Intermediate interactions
Ø Biomolecule’s response to binding or unbinding

Binding is an essential physiological process.

Ibuprofen (Advil©) bound to Cyclooxygenase enzyme



Binding free energy (∆G)
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§ Binding free energy between two biomolecules indicates the strength of binding.
§ It is an amount of energy required to disassemble a whole system into separate parts.

Connection between experiments and binding free energy (∆Gbind):

𝑅 + 𝐼 ⇆ 𝑅𝐼
R = Receptor, I = Inhibitor, kon = association/on-rate constant, koff = dissociation/off-rate 

constant 

𝐾!" =
#!"
#!##

where Keq = equilibrium binding constant
The  experimental binding constant Keq is directly related to free 
energy:

∆𝐺$%&' = −𝑅𝑇𝑙𝑛𝐾!"
R= Ideal gas constant, T= Temperature

Change in the ∆Gbind of ~1.5 kcal/mol alters binding affinity prediction by one order of magnitude



Applications of binding free energy calculations
Ø Antibody binding to an antigen (i.e. protein-protein binding)
Ø Protein-ligand binding
Ø Protein-substrate binding
Ø Protein-DNA/RNA binding
Ø Protein-ion binding
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Protein-protein interaction



Binding free energy calculations using 
molecular modeling
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Fast methods (e.g. docking)
Ø Very quick but cannot quantitatively estimate binding free energy

(∆Gbind).
Ø Neglecting receptor flexibility is often their main limitation.
Ø Widely used for drug design by big pharma companies

Slow methods
Ø Full atomistic molecular dynamics simulations.



Fast methods: Computational Drug Design

9

Two major contributions/challenges:

ØBinding design – new inhibitors
• Compound design is based on the interaction of the ligand with the 

receptor

ØFrom inhibitors to drugs
• Compound optimization is based on some key physico-chemical 

features of active compounds.



Fast methods: Computational Drug Design
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Two approaches:

ØStructure-Based Drug Design – SBDD
• Drug design based on the interaction of the ligand with the 3-D

dimensional structure of the receptor

ØLigand-Based Drug Design – LBDD
• Unknown structure of the receptor. Drug design based on the key

features of active compounds.
• Hypothesis: Ligands similar to an active ligand are more likely to be

active than random ligands.



Fast methods: Computational Drug Design

11

Approaches and Methods:

ØStructure-Based Drug Design – SBDD
• Docking (Glide, Dock, Autodock, ICM... etc)

(Kitchen D., Nat. Review Drug Discovery Vol. 3 Nov. 2004)

ØLigand-Based Drug Design – LBDD
• Quantitative Structure-Activity Relationship (QSAR)

(Markus A. Lill, Drug Discovery Today, Vol. 12 Dec. 2007)

• Ligand similarity approaches (2D or 3D)
(Johann Gasteiger, J. Med. Chem. 49, 22, 2006)



Molecular Docking
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Docking
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USS Hornet, SF Bay, CA, USA 



Docking

14



Docking Molecules…
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A fast attempt to predict the structure(s) of complex formed between the 
ligand and the macromolecule 



Ligand docking
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Two Problems to solve:
ØPosing (the easy part)
ØScoring (the tough part)



Identification of the binding pocket and defining 
a search space 
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• Identify the binding pocket.
• Create a grid box around the binding pocket.
• Major assumption: the receptor is fixed 



Ligand Docking - Posing
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• Ligand conformational sampling … easy, but not that easy 
though!
Example for a small organic molecule
– 6 roto/translational degrees of freedom + 4 (example) rotatable 

bonds
– Cubic shape active site 103 Å3
– 10 degrees increments for rotations
– 0.5 Å grid for translation

• How long would it take to sample all possible conformations, searching 
100 conformation per second ?

~200 years!!!



Posing – Monte Carlo Search
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ØMonte Carlo sampling, which is a stochastic method employed to explore
ligand conformational space.

Ø Tabu Search: a variant of Monte Carlo method, keeps the history of the
previously explored conformations to prevent re-visiting the same
conformations.

Conformation of the ligand 
is randomly changed

Calculate the energy of the 
ligand using molecular 

mechanics

Use standard Metropolis 
criterion to accept or reject 

the move 



Posing – Genetic Algorithm
• Genetic algorithm, which is a stochastic method that employs 

schemes adapted from the biological evolution.
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Create population of random conformations

Fitness function evaluation

Reproduction: Mating & Mutation

Fitness function evaluation

Replace worst scoring conformations in the population

At iteration limit?

Final docked solutions

Yes

No



Posing – Anchor and Grow Algorithm
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• One way to sample the chemical space is
the: Incremental method, which addresses
the combinatorial explosion issues.

• DOCK4.0 is based on an incremental
construction algorithm named anchor and
grow.

Steps involved:
• The ligand anchor is detected
• The anchor fragment is placed in the binding

site
• Layered Incremental Ligand Construction
• The thoroughness of sampling is enhanced

by on-the-fly optimization



Posing – Pregenerated Conformational Libraries
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• Pregenerated conformational libraries, which include multiple
conformers per molecule. Each of the generated conformers will be
docked rigidly into the receptor, and its fit with the binding site will be
determined.



Posing – Molecular Dynamics Simulation
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• Alternatively, one could use Molecular Dynamics, which includes the
flexibility of the receptor. However, it is computationally highly
expensive (several months) compared to standard docking methods
(minutes).

Docking simulation



Posing – Molecular Dynamics Simulation
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• Major advantage of Molecular Dynamics (MD): it accounts for receptor
flexibility.

Examples of problems that can be investigated by using MD:
• Induced-fit: the ligand and the protein adjust their conformation to achieve an

overall “best-fit”.

• Selected-fit: the protein exists in a conformation that binds the ligand.
However, such protein conformation is not the lowest energy conformation.

T. R. Weikl and C. von Deuster Proteins 2009;75:104–110



Posing – a solved problem

25

• The posing is a “solved” problem!

• Docking methods can place a ligand with great accuracy in a binding
pocket, reproducing crystallographic data.

• The challenging issue is to rank different poses, according to their
score and identify the “best one”.

Docking and scoring in virtual screening for drug discovery: methods and applications. Douglas B. Kitchen et al. Drug 
Discovery, Vol. 3, Nov 2004



Ligand Docking - Scoring
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• Docking programs generate a large number of potential ligand poses,
which are evaluated and ranked using some scoring function.

• Ideally, we would want to determine the equilibrium binding constant
(Keq) for each docking pose. Keq is directly related to the Gibbs free
energy:

Why is it so difficult to score compounds?
• Experimental range of binding affinities: from 10-2 M (mM) to 10-12 M (pM)
• At T=298K the ΔG binding is between -2.4 kcal/mol and -16.7 kcal/mol
• In other words, a change in binding (free) energy of ~1.5 kcal/mol alters the binding 

affinity of one order of magnitude (T=298) !!!!



Ligand Docking - Scoring
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Contribution to binding affinity
Ø Electrostatic Contribution
•  H-bonds
•  Salt-Bridges
•  π – π interactions, π – cation interactions
•  coordination

Ø Solvation/Desolvation Effect

Ø Loss of Conformational Entropy
•  Roto/Translational Entropy
•  Conformational Mobility



Ligand Docking - Scoring
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ΔSsolute: The solute entropy consists of four terms, namely translational,
rotational, vibrational, and conformational entropy.
ΔGsolvent: The solvent free energy consists of the two terms: 1) a nonpolar
and a polar term.



Ligand Docking - Scoring
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Other scoring functions:
ØEmpirical scoring function is derived from a training set of co-

crystals whose binding affinities were experimentally determined.

ØKnowledge based scoring function, if a large enough set is
considered, general rules can be derived from simple statistics.

ØConsensus scoring function, use of multiple scoring function can
help overcoming the limitations of each single scoring function.

Example:

Score = sum of scores from different scoring functions / Number of
scoring functions.



Virtual ligand screening
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Docking of databases containing virtual compounds:
• Millions of compounds can be docked in a virtual screening

experiment.
• Out of millions, compounds with the best score are prioritized for

synthesis and testing.
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Autodock Vina Docking Tutorial
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Tasks
1. Download and install necessary input files and programs.

2. Reproduce the experimental binding conformation of imatinib (drug) 
by docking it using Autodock Vina program to its target protein, the 
kinase domain of c-Abl.
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Task 1: Download and install files
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Download and install files
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• UCSF Chimera (https://www.cgl.ucsf.edu/chimera/download.html), 
download and install. Available for Mac, Windows and Linux

• Autodock Vina (http://vina.scripps.edu/download.html), download and 
install. Available for Mac, Windows and Linux. (Mac users should copy 
the “bin” folder under your applications folder and change your settings 
to run third-party apps.

• Input files for docking (http://vina.scripps.edu/tutorial.html) (Scroll down 
on this page, you will notice input file download link below a youtube
video, file name is vina_tutorial.zip)

Video tutorials
• UCSF Chimera Basic Operations: 

(https://www.youtube.com/watch?v=hQxKYSUdiD8)

• Autodock vina docking tutorial using UCSF Chimera: 
(https://www.youtube.com/watch?v=cLGQ-951FDk) 

https://www.cgl.ucsf.edu/chimera/download.html
http://vina.scripps.edu/download.html
http://vina.scripps.edu/tutorial.html
https://www.youtube.com/watch?v=hQxKYSUdiD8
https://www.youtube.com/watch?v=cLGQ-951FDk


Task 2: Reproduce the experimental binding 
conformation of imatinib 
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Task 2: steps involved
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1. Load protein and ligand files into UCSF Chimera
2. Launch Autodock Vina on UCSF Chimera
3. Set up receptor search space
4. Protein and Ligand preparation
5. Set up docking parameters
6. Locate vina executable and run docking calculation
7. Analyzing docking results



Step 1: Load protein and ligand files into UCSF 
Chimera
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Step 1: Load protein file into UCSF Chimera
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File > Open > Find the location of your input files > vina_tutorial > select protein.pdb
(I saved my input file folder “vina_tutorial” on desktop folder on my machine)



Step 1: Load ligand file into UCSF Chimera
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File > Open > Find the location of your input files > vina_tutorial > select ligand.pdb
(I saved my input file folder “vina_tutorial” on desktop folder on my machine)

UCSF Chimera GUI
should now have 
protein and ligand



Step 1: Check protein and ligand files in Model 
panel
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Favorites > Model Panel
Model Panel helps you take control of the structures loaded on your screen. 

You can hide structures by unchecking “s” in the Model Panel



Step 2: Launch Autodock Vina on UCSF 
Chimera
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Step 2: Launch Autodock Vina on UCSF 
Chimera
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Tools > Surface/Binding Analysis > Autodock Vina
This will open up a new window with options for running Autodock Vina



Step 2: Set up Autodock Vina Output file 
location
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Click on “Browse” > this will open “Save File in Chimera” window >  Select 
output file folder > select file name

Then select Receptor and Ligand files indicated by #0 and #1
Note the file format is now set to pdbqt, a pdb file with charges.



Step 3: Set up receptor search space
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Step 3: Set up receptor search space
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Select > Chain > B
Actions > Surface > show

Rotate the protein in the sphere representation to visually locate the binding pocket.

Prior to setting up a receptor search space, let us change protein’s representation from 
ribbon to surface to better visualize and identify the location of the binding pocket.



Step 3: Set up receptor search space
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Locate the binding pocket (shown on the left, appears to be a tunnel)
Autodock Vina panel > check “Resize search volume using” > select “ctrl button 3”

Press ctrl and button 3 (right click button of your mouse) on the surface representation of 
the protein and place a grid box around the binding pocket.



Step 3: Set up receptor search space
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Press ctrl and button 3 (right click button of your mouse) on the surface representation of 
the protein and place a grid box around the binding pocket. Create a box that is small 
enough to cover the entire binding pocket.



Step 4: Protein and Ligand preparation
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Step 4: Protein and Ligand preparation

51

Autodock Vina Panel > Receptor options > leave all to default
Autodock Vina Panel > Ligand options > leave all to default



Step 5: Set up docking parameters

52



Step 5: Set up docking parameters

53

Autodock Vina panel > Advanced 
options > select defaults

- Number of binding modes: number 
of different predicted docking 
poses you want to see for your 
ligand.

- Exhaustiveness: this parameter is 
directly proportional to time. 
Higher the number more rigorous 
would be the search.

- Max. energy difference: max. 
docking score energy difference 
between your top docking pose 
and the next docking pose.    



Step 6: Locate vina executable and run docking
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Step 6: Locate vina executable and run docking

Autodock Vina panel > Executable 
location > check ”Local” > find the

vina executable on your machine. > 
click “OK” to run docking calculation

Note: Vina executable file on my Mac 
is located in Applications folder 
(/Applications/Vina/vina). You may 
have a different location on your 
machine.

- If docking calculation is running, it 
should say “running” at the bottom 
of the UCSF chimera status bar.

- Docking takes ~20 seconds to 
complete on my machine.
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Step 7: Analyzing docking results



Step 7: Analyzing docking results
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Docking results panel will pop up 
after the calculation has finished. 
Panel will list the top five docking
poses with their docking scores. 
Observe the different docking pose 
by playing them.

ViewDock > Movie > Play



Step 7: Compare docked top pose with 
experimental pose of imatinib
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Load the experimental pose of imatinib for comparison. 

UCSF Chimera > File > Open > Locate Vina_tutorial > Select
“ligand_experiment.pdb” > Open



Step 7: Compare docked top pose with 
experimental pose of imatinib
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For better comparison of docked pose and the experimental pose of imatinib, 
we will first change the protein representation from Surface to Cartoon.

Model Panel > Uncheck “S” for MSMS surface to hide surface representation > 
Compare experimental pose (pink) vs docked pose (green) vs initial ligand 

pose (blue)



Additional docking tutorial video
• http://vina.scripps.edu/tutorial.html
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http://vina.scripps.edu/tutorial.html

